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End-user license agreement

END-USER LICENSE AGREEMENT
BY ACCEPTING, YOU (ORIGINAL PURCHASER) INDICATE YOUR ACCEPTANCE OF THESE TERMS. IF
YOU DO NOT WISH TO ACCEPT THE PRODUCT UNDER THESE TERMS YOU MAY CHOOSE NOT TO
ACCEPT BY SELECTING "I decline..." AND NOT INSTALLING THE SOFTWARE.
The Acronis® Migrate Easy (the Software) is Copyright © Acronis, Inc., 2000–2007. All rights are
reserved. The ORIGINAL PURCHASER is granted a LICENSE to use the software only, subject to the
following restrictions and limitations.
1.

The license is to the original purchaser only, and is not transferable without prior written
Permission from Acronis.

2.

The Original Purchaser may use the Software on a single computer owned or leased by the
Original Purchaser. You may not use the Software on more than a single machine even if you
own or lease all of them without the written consent of Acronis.

3.

The Original Purchaser may not engage in, nor permit third parties to engage in, any of the
following:

A.

Providing or permitting use of or disclosing the Software to third parties.

B.

Providing use of the Software in a computer service business, network, timesharing or multiple
user arrangement to users who are not individually licensed by Acronis.

C.

Making alterations or copies of any kind in the Software (except as specifically permitted above).

D.

Attempting to un-assemble, de-compile or reverse engineer the Software in any way.

E.

Granting sublicenses, leases, or other rights in the Software to others.

F.

Making copies, or verbal or media translations, of the users guide.

G.

Making telecommunication data transmission of the software.

Acronis has the right to terminate this license if there is a violation of its terms or default by the
Original Purchaser. Upon termination for any reason, all copies of the Software must be immediately
returned to Acronis, and the Original Purchaser shall be liable to Acronis for any and all damages
suffered as a result of the violation or default.
ENTIRE RISK
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE IS WITH YOU THE
PURCHASER. ACRONIS DOES NOT WARRANT THAT THE SOFTWARE OR ITS FUNCTIONS WILL MEET
YOUR REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR
ERROR FREE OR THAT ANY DEFECTS WILL BE CORRECTED. NO LIABILITY FOR CONSEQUENTIAL
DAMAGES - IN NO EVENT SHALL ACRONIS OR ITS VENDORS BE LIABLE FOR ANY DAMAGES
WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR THE LOSS OF BUSINESS
PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER
PECUNIARY LOSS) ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF
ACRONIS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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Introduction

Introduction
1.1

What is Acronis® Migrate Easy?

Upgrade Your Hard Disk Drive in Minutes!
It’s finally time. You’ve put it off as long as possible, but it’s now time to upgrade to
a new hard disk drive. And if you’re like most users, you’re not excited, you’re
scared. You think you’re in for a large project spanning several days of tedious
work. Luckily for you, there’s Acronis Migrate Easy, an award-winning solution that
migrates all your computer data to a new hard disk drive in minutes, and keeps all
operating systems and applications fully functional just the way you had them. Why
take days upgrading when you can use Acronis Migrate Easy and be finished in
minutes?
Upgrading Has Never Been Easier or Safer!
And with Acronis Migrate Easy, you don’t have to be a computer whiz to upgrade to
a new hard disk drive. Simply make a few choices when prompted, and Acronis
Migrate Easy will take care of everything else automatically. It will even show you a
preview of the migration so you are sure to migrate exactly what you intend to.
Within minutes, your data, including applications and operating systems, will be
safely on your new hard disk drive and ready to go!
Acronis Migrate Easy key features:







Clone an old hard disk drive to a new one
Automatic and manual hard disk upgrade modes
Install new hard disk drive as a boot disk or as an additional storage device
Redeploy old hard disk
Resize transferred partitions to match new hard disk size
Securely clean and wipe old hard disk

Supported operating systems
 Windows 98/Me
 Windows NT 4.0 Workstation/Server
 Windows 2000 Professional/Server/Advanced server
 Windows XP
 Windows 2003 Server
 Windows Vista
Supported file systems
 FAT 16/FAT 32
6

Copyright © Acronis, Inc., 2000–2007

Introduction

 NTFS
 Ext2/Ext3,
 ReiserFS
 Linux Swap
 sector-based support for other operating systems
Navigating the Guide

1.2



This user’s guide contains the following main chapters:



Chapter 1 «Installation and operation» — contains detailed information about the
installation and running Acronis Migrate Easy.



Chapter 2 «General program information»— describes components parts of the
software and user’s interface.



Chapter 3 «Transferring the system to a new disk» - describes process of
transferring of system on a new hard disk by cloning of an old disk



Chapter 4 «Adding a new hard disk» - describes how to add a new disk only to
store data, leaving the system on the old disk.



Appendix A «Hard disks and BIOS setup» - provide you with extra information on
the hard disk organization, how information is stored on disks, how disks should
be installed in the computer and plugged into the motherboard, configuring disks
with BIOS, partitions and file systems, and how operating systems interact with
disks.



Appendix B «Partitions and file systems» - contains general information on disk
partitioning and main file systems types.

Software usage terms and conditions
The conditions for Acronis Migrate Easy software usage are described in the
«License Agreement» included with this package. The supplied registration card is
the confirmation of your legal purchase and usage of Acronis Migrate Easy on your
system. Each registration card has a unique registration number.
Under current legislation, the «License Agreement» is considered a contract
between you and Acronis Inc. The contract is a legal document and its violation may
result in legal action.
Illegal use and/or distribution of this software will be prosecuted.

1.3

Technical Support
Users of legally purchased copies of Acronis Migrate Easy are entitled to free e-mail
technical support from Acronis. If you have installation or working problems that

Copyright © Acronis, Inc., 2000–2007
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you can’t solve by yourself using this manual and the readme.txt file, e-mail or fax
the technical support team.
Before you do this, you will have
http://www.acronis.com/registration/ or by mail.

to

register

your

copy

at

When contacting technical support, you must provide the number of your Acronis
Migrate Easy copy that is written on a registration card bundled with the program.
This number is made up of five sets of five characters separated by hyphens; there
is a total of 25 letters and numbers.
For more information visit http://www.acronis.com/support/
Technical support e-mail address: support@acronis.com
Fax technical support at: (650) 875-7587

8

Copyright © Acronis, Inc., 2000–2007

Installation and operation

Chapter 1. Installation and operation
1.1

Bundle contents
The Acronis Migrate Easy system package includes:
• an installation disk
• user manual
• License Agreement
• registration card
• advertising materials

1.2

System requirements
Acronis Migrate Easy requires the following hardware:
• Pentium or compatible PC
• 32 (64 for a full version) MB RAM
• floppy disk drive or CD-ROM drive
• mouse (recommended)
• free hard disk space for image files
A CD-ROM drive is required to install Acronis Migrate Easy

1.3

Acronis Migrate Easy installation
To install Acronis Migrate Easy:
1. Insert the installation CD into your drive.
2. Follow the instructions on the screen.
3. After making your installation choices and copying Acronis Migrate Easy files
onto your hard disk, you will be prompted to create a bootable diskette or
CD-R/W. (You can omit this step if you have purchased the boxed product that
contains a bootable CD). While Acronis Migrate Easy creates disk images in
Windows, it might be necessary to restore the image from a bootable disk.
Therefore, it is strongly recommended that you create one. However, you can
do that after the installation as well.
After installation of Acronis Migrate Easy is completed, you should restart your
computer.

Copyright © Acronis, Inc., 2000–2007
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1.4

Running Acronis Migrate Easy
In normal mode, you can run Acronis Migrate Easy from Windows by selecting
Acronis → Migrate Easy → Acronis Migrate Easy, from Start → Programs.
This will bring the program window onto the screen.

1.5

Removing the program
To remove Acronis Migrate Easy from your PC, select Acronis →Migrate Easy →
Uninstall Acronis Migrate Easy in the Programs menu. You will see a dialog to
confirm the program removal. Click Yes to confirm and Acronis Migrate Easy will be
completely removed. You may have to reboot your computer afterwards to
complete the task.

10
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Chapter 2. General program information
2.1

Main program window
The main program window contains the menu, toolbar and the Windows XP
Explorer-like interface divided into two areas. The right area contains operation
icons; the left one has corresponding action descriptions, typical actions and
additional tools.

The main program window

The menu, toolbar and menu items in the left area duplicate themselves, providing
more convenience.
Having selected (clicked) an operation, you can execute it in several ways: by
double-clicking its icon, by selecting Start Now in the Operations menu, by
selecting the same operation in the Operations window, or by clicking Start Now
on the toolbar.
The main window contains the New Disk Deployment group includes operations
required when a new disk drive is installed:
• Disk Clone – transfer operating system, applications and data from the old disk
to the new one
• Add New Disk – add a disk for data storage, leaving the operating system and
applications on the old drive

Copyright © Acronis, Inc., 2000–2007
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Program menu
The program menu line contains the Operations, View, Tools, and Help items.
The Operations menu changes when either an operation icon or scheduled task is
selected. In the first case, the menu contains only Start Now to execute the
selected operation.
The Tools menu contains the following items:
• Create Bootable Rescue Media – runs the bootable media creation procedure
The View menu contains items for managing the program window look:
• Toolbars – contains commands that control toolbar icons
• Common Task Bar – enables/disables common task panel in the left area
• Status Bar – enables/disables the status bar
• Tiles Icons List – controls how operation icons look
• Refresh – refreshes the main program window
The Help menu allows you to invoke help and get information about Acronis
Migrate Easy.

12
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Chapter 3. Transferring the system to a new
disk
3.1

General information
Sooner or later, many PC users find that their hard disk is too small. If you just
don’t have space for more data, you can add another disk just for data storage as
described in the following chapter.
However, you might find that your hard disk does not have enough space for the
operating system and installed applications, preventing you from updating your
software. In this case, you have to transfer the system to a higher-capacity hard
disk.
To do that, you must first install the disk in the PC. Although this operation is
relatively simple, we do not recommend that inexperienced users perform it
themselves; you should have a professional to do it. If you still want to do this
yourself, see Appendix B.
If a PC doesn’t have a bay for another hard disk, you can temporarily install it in place of your
CD-ROM. If it’s still impossible, you can clone a hard disk by creating its image and restoring it
to a new hard disk with larger partitions. Creating an image requires Acronis True Image
software.

There are two transfer modes available: automatic and manual.
In the automatic mode, you will only have to take a few simple actions to transfer
all the data, including partitions, folders and files, to a newer disk. You also will
make the disk bootable if the original disk was bootable.
There will be only one difference between these disks – partitions on the newer disk
will be larger. Everything else, including the installed operating systems, data, disk
labels, settings, software and everything else on the disk will remain the same.
This is the only result available in the automatic mode. The program can only duplicate the
original disk layout to the new one. To obtain a different result, you will have to answer
additional questions about cloning parameters.

The manual mode will provide more data transfer flexibility.
1. You will be able to select the method of partition and data transfer:
• as is
• new disk space is proportionally distributed between the old disk partitions
• new disk space is distributed manually
Copyright © Acronis, Inc., 2000–2007
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2. You also will be able to select operations to perform on the old disk:
• leave partitions (and data) on the old disk
• remove all information from the old disk
• Create new partitions on the old disk (and remove all the older information)
On all screenshots below, damaged partitions are marked with a red circle and a white cross
inside in the upper left corner. Before you start cloning, you should check such disks for errors
using corresponding operating system tools.

3.2

Security
Please note the following: if the power goes out or you accidentally press RESET
during the transfer, the procedure will be incomplete and you will have to partition
and format or clone the hard disk again.
No data will be lost on the original disk; it was only being read (no partitions were
changed or resized).
We do not recommend that you delete data from the old disk until you are sure it is
correctly transferred to the new disk, the PC boots up from it and all applications
work.

3.3

Executing transfers

Selecting transfer mode
You will see the Select transfer mode window just after the welcome window.

Transfer mode selection
14
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We recommend using automatic mode in most cases. The manual mode can be
useful if you need to change the disk partition layout.
If the program finds two disks, one partitioned and another unpartitioned, it will
automatically recognize the source disk as the partitioned disk and the destination disk
as the unpartitioned disk, so the next two steps will be bypassed.

Selecting source disk
If the program finds several partitioned disks, it will ask you which is the source (i.e.
the original data disk).

You can determine the source and destination using the information provided in this
window (disk number, capacity, label, partition and file system information).

Selecting destination disk
After you select the source disk, you have to select the destination where the disk
information will be copied.

Copyright © Acronis, Inc., 2000–2007
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The previously selected source becomes grayed-out and disabled for selection.
If either disk is unpartitioned, the program will automatically recognize it as destination and
bypass this step.

Partitioned destination disk
At this point, the program checks to see if the destination disk is free. If not, you
will be prompted by the Partitioned destination disk window stating that the
destination disk contains partitions, perhaps with data.

16
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You can continue once existing partitions are deleted

You will have to select between:
• Delete partitions on the destination hard disk – all existing partitions will
be deleted during cloning and all their data will be lost.
• No, I do not want to delete partitions – no existing partition will be deleted,
discontinuing the cloning operation. You will only be able to cancel this
operation and return to select another disk.
To continue, select the first choice and click Next.
Note that no real changes or data destruction will be performed at this moment! For now, the
program will just create a cloning script. All changes will be implemented only when you click
Proceed, after the script is formed.

Old and new disk partition layout
If you selected the automatic mode before, the program will not ask you for any
further information. You will see the window graphically illustrating information (as
rectangles) about the source disk (partitions and unallocated space) and the
destination disk layout.
Along with the disk number, some additional information is provided: Partition
number, volume label (e.g. SYSTEM), file system (e.g. FAT16 or FAT32), and
partition size in megabytes (MB). Partition types — primary, logical — and
unallocated space are marked with different colors.
Next you will see the cloning script.

Old disk data
If you selected the manual mode, the program will ask you what to do with the old
disk:
• Create a new partition layout – All existing partitions and their data will be
deleted (but they will also be cloned to the new disk, so you won’t lose them)
• Keep data – leave the old disk partitions and data intact
• Destroy data – delete partitions (and data!) from the old disk

Copyright © Acronis, Inc., 2000–2007
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If you are going to sell or dispose of your old disk, we recommend that you make
sure you destroyed all the data on it.
If you are going to keep it for data storage, you can create a new partition layout
on it. In this case, the disk will be ready right after cloning is complete. To protect
yourself from unforeseen consequences, it would be better to leave the old disk
data intact, as you will be able to delete it later.

Destroying the old disk data
If you elected to destroy data, you will have to select the destruction method now:
• Quick – one-pass destruction
• Normal – guaranteed multipass destruction

18
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The second method takes more time, but makes it impossible to recover data
afterwards, even with special equipment.
The first method is less secure, but is still suitable for most cases.

Selecting partition transfer method
Acronis Migrate Easy will offer you the following data transfer methods:
• As is
• Proportional – the new disk space will be proportionally distributed between
cloned partitions
• Manual – you will specify the new size and other parameters yourself

If you elect to transfer information "as is," a new partition will be created for every
old one with the same size and type, file system and label. The unused space will
become unallocated. Further, you will be able to use the unallocated space to create
new partitions or to enlarge the existing partitions with special tools, such as
Acronis Disk Director.
As a rule, "as is" transfers are inexpedient, as they leave much unallocated space on
the new disk.
If you transfer data proportionally, each partition will be enlarged, according to the
proportion of the old and new disk capacities.
Using the "as is" method, Acronis Migrate Easy also transfers unsupported and
damaged file systems.
FAT16 partitions are enlarged less than others, as they have the 4 GB size limit.

Copyright © Acronis, Inc., 2000–2007
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Depending on the selected combination, you will proceed to either the old disk
partitioning window, or the disk partition layout window (see below).

Partitioning the old disk
If you selected Create a new partition layout earlier in the process, it is now
time to repartition your old disk.
During this step, you will see the current disk partition layout. Initially, the disk has
unallocated space only. This will change when you create new partitions.
Having completed the required steps, you will add a new partition. To create
another one, simply repeat those steps.
If you make a mistake, click Back to redo.
After you create the necessary partitions, uncheck the Create new partition in
unallocated space box and click Next.

Old and new disk partition layouts
In the next window, you will see rectangles indicating the source hard disk,
including its partitions and unallocated space, as well as the new disk layout.

Along with the hard disk number, you will also see partition number, volume label
(e.g. SYSTEM), file system (e.g. FAT16 or FAT32), partition size in megabytes (MB).
Different partition types, including primary, logical and unallocated space are
marked with different colors.

20
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If you have selected manual partition creation before, the partition layout will look different.
This partitioning method is described below.

Cloning script
In the next window, you will see the disk cloning script containing a list of briefly
described operations to be performed on the partitions.

Disk partitioning script

After you click Proceed, Acronis Migrate Easy will start cloning the old disk to the
new disk, indicating the progress in the special window. You can stop this procedure
by clicking Cancel. In that case, you will have to repartition and format the new
disk or repeat the cloning procedure.
After the operation is complete, you will see the results message.

3.4

Cloning with manual partitioning

Old and new disk partition layouts
The manual transfer method enables you to resize partitions on the new disk. By
default, the program resizes them proportionally.
In the next window, you will see rectangles indicating the source hard disk,
including its partitions and unallocated space, as well as the new disk layout.
Copyright © Acronis, Inc., 2000–2007
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Along with the hard disk number, you will see partition number, volume label (e.g.
SYSTEM), file system (e.g. FAT16 or FAT32) and partition size in megabytes (Mb).
Different partition types, including primary, logical and unallocated space are
marked with different colors.

To resize either partition, check the Proceed Relayout box. If you are satisfied
with the partition layout shown, uncheck this box (if checked). Clicking Next, you
will proceed to the cloning script window.
Be careful! Clicking Back in this window will reset all size and location changes that you've
selected, so you will have to specify them again.

First, select a partition to resize. It will be underlined in red.
Resize and relocate it on the next step.
You can do this by both entering values to Unallocated space before, Partition
size, Unallocated space after fields, by dragging partition borders or the
partition itself.
If the cursor turns to two vertical lines with left and right arrows, it is pointed at the
partition border and you can drag it to enlarge or reduce the partition’s size. If the
cursor turns to four arrows, it is pointed at the partition, so you can move it to the
left or right (if there's unallocated space near it).
Having provided the new location and size, click Next. You will be taken two steps
back to the partition layout. You might have to perform some more resizing and
relocation before you get the layout you need.

22
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Chapter 4. Adding a new hard disk
If you don't have enough space for your data (e.g. family photos and videos), you
can either replace the old disk with a new higher-capacity one (data transfers to
new disks are described in the previous chapter), or add a new disk only to store
data, leaving the system on the old disk. If the PC has space for another disk, it
would be easier to add a disk drive than to clone one.
To add a new disk, you must first install it in your PC. Although this operation is
relatively simple, we do not recommend it for inexperienced users, and advise them
to have a professional do it. If you still want to install it yourself, first take the time
to study Appendix B.

4.1

Selecting a hard disk
Select the disk that you've added to the PC.

This window might be bypassed if the program detects the new disk itself. In this
case, you will immediately proceed to the New partition creation.

If there are any partitions on the new disk, they must be deleted first.
Select Delete partitions on the destination hard disk and click Next to
continue.

Copyright © Acronis, Inc., 2000–2007
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4.2

Creating a new partition
Next you will see the current partition layout. Initially, all disk space will be
unallocated. This will change after you add new partitions.
To create a partition, select Create new partition in unallocated space and
click Next to perform steps required by the partition creation wizard.
If you make a mistake at partitioning, click Back to redo the process.
After you create the necessary partition layout, uncheck the Create new partition
in unallocated space box and click Next.

4.3

Selecting the file system type
During creation of the new partition you should choose type of file system for him.
Acronis Migrate Easy supports all Windows file systems (FAT 16, FAT32 and NTFS),
and also the most popular Linux file systems (Ext2, Ext2, ReiserFS and Linux Swap).
Also you can mark new partition as unformatted.

File System Type window

4.4

Selecting the partition type
Next step is type of new partition selecting.
If you plan to boot from new partition, create it as the Primary partition.
If you do not plan to boot from this partition, create it as logical drive.
24
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Partition type window

4.5

Disk add script
In the next window, you will see the disk add script containing a list of briefly described
operations to be performed on partitions (disks).

Disk imaging script

Copyright © Acronis, Inc., 2000–2007
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After you click Proceed, Acronis Migrate Easy will start creating and formatting new
partitions, indicating the progress in the special window. You can stop this
procedure by clicking Cancel. In that case, you will have to repartition and format
the new disk or repeat the disk add procedure.
After the operation is complete, you will see the results message.

26
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Appendix A. Hard disks and BIOS setup
The appendices below provide you with extra information on the hard disk
organization, how information is stored on disks, how disks should be installed in
the computer and plugged into the motherboard, configuring disks with BIOS,
partitions and file systems, and how operating systems interact with disks.

A.1
A.1.1

Installing hard disks in computers
Installing a hard disk, general scheme
To install a new IDE (Integrated Drive Electronics) hard disk, you should do the
following (we will assume you have powered OFF your PC before you start!):
1. Configure the new hard disk as slave by properly setting the jumpers on the
drive. Disk drives generally have a picture on the drive that shows the correct
jumper settings.
2. Open your computer and insert the new hard disk into a 3.5’’ or 5.25’’ slot with
special holders. Fasten down the disk with screws.
3. Plug the power cable into the hard disk (four-threaded: two black, yellow and
red; there is only one way you can plug in this cable).
4. Plug the 40- or 80-thread flat data cable into sockets on the hard disk and on the
motherboard (plugging rules are described below). The disk drive will have a
designation on the connector or next to it that identifies Pin 1. The cable will have
one red wire on an end that is designated for Pin 1. Make sure that you place the
cable in the connector correctly. Many cables also are “keyed” so that they can only
go in one way.
5. Turn your computer on and enter BIOS setup by pressing the keys that are
displayed on the screen while the computer is booting.
6. Configure the installed hard disk by setting the parameters type, cylinder, heads,
sectors and mode (or translation mode; these parameters are written on the hard
disk case) or by using the IDE autodetection BIOS utility to configure the disk
automatically.
7. Set the boot sequence to A:, C:, CD-ROM or some other, depending on where
your copy of Acronis Migrate Easy is located. If you have a boot diskette, set
the diskette to be first; if it is on a CD, make the boot sequence start with CDROM.
8. Save changes and quit BIOS setup. Acronis Migrate Easy will automatically start
after reboot.
9. Use Acronis Migrate Easy to configure hard disks by answering the wizard’s
questions.
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10. After finishing the work, turn off the computer, set the jumper on the disk to the
master position if you want to make the disk bootable (or leave it in slave position
if the disk is installed as additional data storage).
A.1.2

Motherboard sockets, IDE cable, power cable
There are two slots on the motherboard to which the hard disks can be connected:
primary IDE and secondary IDE.
Hard disks with an IDE interface are connected to the motherboard via a 40- or 80thread flat marked cable — one of the threads of the cable is red.
Two IDE hard disks can be connected to each of the sockets, i.e. there can be up to
4 hard disks of this type installed in the PC. (There are three plugs on each IDE
cable: 2 for hard disks and 1 for the motherboard socket.)
As noted, IDE cable plugs are usually designed so that there is only one way to
connect them to the sockets. Usually, one of the pinholes is filled on the cable plug,
and one of the pins facing the filled hole is removed from the motherboard socket,
so it becomes impossible to plug the cable in the wrong way.
In other cases, there is a jut on the plug on the cable, and an indentation in the
socket of the hard disk and of the motherboard. This also ensures that there only
one way to connect the hard disk and the motherboard.
In the past, this design of plug did not exist, so there was an empirical rule: the IDE

cable is connected to the hard disk socket so that the marked thread is the closest
to the power cable, i.e. the marked thread connected to pin #1 of the socket. A
similar rule was used for connecting cables with the motherboard.

Incorrect connection of the cable with either the hard disk or the motherboard does
not necessarily damage the electronics of the disk or the motherboard. The hard
disk is simply not detected or initialized by BIOS.
There are some models of hard disks, especially the older ones, for which incorrect
connection damaged the electronics of the drive.
We will not describe all the types of hard disks. Currently the most widespread are those with
IDE or SCSI interfaces. Unlike IDE hard disks, there can be from six to 14 SCSI hard disks
installed in your PC. However, you need a special SCSI controller (called a host adapter) to
connect them. SCSI hard disks are not usually used in personal computers (workstations), but
are found mostly in servers.

Aside from an IDE cable, a 4-thread power cable must be connected to the hard
disks. There is only one way to plug in this cable.
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A.1.3

Installation modes, jumpers
1. A hard disk can be installed in a computer as master or as slave. The mode of
hard disk installation is defined by the position of special connectors (called
jumpers) on the hard disk.
The jumpers are either located on the electronic board of the hard disk or a special
socket that provides for the connection of the hard disk and the motherboard.
There is usually a sticker on the drive that explains the markings. Typical markings are
DS, SP, CS and PK.
Each jumper position corresponds to one hard disk(s) installation mode:
•

DS – master/factory default

•

SP – slave (or no jumper required)

•

CS – cable select for master/slave: the purpose of the hard disk is determined by
its physical position with respect to the motherboard

•

PK – jumper parking position: the position where one can put the jumper if it is
not necessary in the existing configuration

The hard disk with the jumper in master position is treated by the basic input/output
system (BIOS) as bootable.
The jumpers on hard disks that are connected to the same cable can be in the cable
select for master/slave position. In this case, BIOS will deem as «master» the disk
that is connected to the IDE cable closer to the motherboard than the other one.
Unfortunately, hard disk markings were never standardized. You might well find that markings
on your hard disk differ from the ones described above. Moreover, for the older types of hard
disks, their purpose could be defined by two jumpers instead of one. You should study the
markings carefully before installing your hard disk in the computer.

It is not enough to physically connect the hard disk to the motherboard and set the
jumpers properly for the hard disk to function — hard disks have to be properly
configured with the motherboard BIOS.
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A.2

BIOS
When you turn on your computer, you often see a number of short text messages
before you see the splash screen of your operating system. These messages are
from the POST (power-on self test) program that belongs to BIOS and is executed
by the processor.
BIOS, or the basic input/output system, is a program that resides in the permanent
memory chip (ROM or flash BIOS) on the motherboard of your computer and is its
key element. The version of BIOS that you use «knows» all the peculiarities of all
the components of the motherboard: processor, memory, integrated devices. BIOS
versions are provided by the manufacturers of motherboards.
Main BIOS functions are:
• POST checking of processor, memory and I/O devices
• initial configuring of all software-manageable parts of the motherboard
• initialization of operating system (OS) booting process
Among numerous components of the computer, initial configuring is necessary for
the external memory subsystem that controls hard disk drives, floppy disk drives,
CD-ROM drives, DVDs and other devices.

A.2.1

Setup utility
BIOS has a built-in setup utility for initial computer configuring. To enter it, you
have to press a certain combination of keys (Del, F1, CTRL+ALT+ESC, CTRL+ESC,
or some other, depending on your BIOS) during the POST sequence that starts right
after you turn your computer on. Usually the message with the required
combination of keys is displayed during the startup testing. Pressing this
combination takes you to the menu of the setup utility that is included in your BIOS.
The menu can differ in appearance and sets of items and their names, depending
on the BIOS manufacturer. The most widely known BIOS makers for PC
motherboards are Award/Phoenix and AMI. Moreover, while items in the standard
setup menu are mostly the same for various BIOSes, items of the extended setup
heavily depend on computer and BIOS version.
Below we describe the general principles of initial hard disk configuring, and then
configuring (sample) in AwardBIOS.
Large PC manufacturers like Dell and Hewlett-Packard produce motherboards themselves, and
develop their own BIOS versions. You should always refer to the documentation that came
with your computer for instructions on proper BIOS configuring.

A.2.2

Standard CMOS setup menu
Parameters in the standard CMOS setup menu usually define the geometry of the
hard disk. The following parameters (and values) are available for each hard disk
installed in your PC:
30
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Parameter
Type

Value

Purpose

1-47, Not
Installed,
Auto

Type 0 or Not Installed is used when there is no
hard disk installed (to uninstall it). Type 47 is
reserved for user-defined parameters or for
parameters detected by the IDE Auto detection
utility.
Auto value allows for automatic detection of IDE
disk parameters during the boot sequence.

Cylinder (Cyl)

1-65535

The number of cylinders on a hard disk. For IDE
disks, a logical number of cylinders is specified.

Heads (Hd)

1-16

The number of heads on a hard disk. For IDE
disks, a logical number of heads is specified.

Sectors (Sec)

1-63

The number of sectors per track of a hard disk. For
IDE disks, a logical number of sectors is specified.

Size (Capacity)

MBytes

The capacity of the disk in megabytes. It is
calculated according to the following formula:
Size=(Cyl x Hds x Sct x 512) / 1024 / 1024.

Mode
(Translation
Method)

Normal/
LBA/
Large/Auto

Method of translation of sector addresses.

For example, to demonstrate the main features of Acronis Migrate Easy we used a
QuantumTM FireballTM TM1700A hard disk as one of the disks in our examples. Its
parameters have the following values:
Parameter

Value

Type

Auto

Cylinder (Cyl)

827

Heads (Hd)

64

Sectors (Sec)

63

Mode

Auto

CHS

1707 MB

Maximum LBA Capacity

1707 MB

In BIOS setup, you can set the Type parameter to User Type HDD (user-defined
type). In this case, you also have to specify the value of the translation mode
parameter, which can be Auto/Normal/LBA/Large.
Translation mode is how sector addresses are translated. This parameter appeared because in
BIOS versions, there were limitations to the maximum address capacity of disks, which is
504 MB (1024 cylinders x 16 heads x 63 sectors x 512 bytes). There are two ways to bypass
this limitation: (1) switch from physical to logical sector addresses (LBA), (2) use mathematics
to reduce the number of addressed sectors (cylinders) and increase the number of heads; this
method is called Large Disk (Large). The simplest decision is to set the value of this
parameter to Auto.
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If there are several hard disks connected to your motherboard, but you do not want
to use some of them at the moment, you have to set the Type of these disks to Not
Installed.
Parameters of hard disks can be set manually with the help of information provided
by the hard disk manufacturer on its case, but it is easier to use the IDE
autodetection utility that is usually included in modern BIOS versions.
The utility is sometimes a separate BIOS menu item and sometimes is included in
the standard CMOS setup menu.
Please note that in Appendix A. «Hard disks and BIOS setup» we have described the general
details of physical hard disk structure. Built-in IDE hard disk controls mask the physical disk
structure. As a result, the BIOS of the motherboard «sees» logical cylinders, heads and
sectors. We are not going to elaborate on this issue here, but knowing about this can
sometimes be useful.

A.2.3

Arranging boot sequence, advanced CMOS setup menu
Aside from standard CMOS setup, BIOS menu usually has an advanced CMOS setup
item. Here you can adjust the boot sequence: C:; A:; CD-ROM:.
Please note that boot sequence management differs for various BIOS versions, e.g. for AMI
BIOS, AWARDBIOS and brand-name hardware manufacturers.

Several years ago, the operating system boot sequence was hard-coded into the
BIOS. An operating system could be booted either from a diskette (drive A:), or
from the hard disk C:. That was the sequence in which the BIOS queried external
drives: if drive A: was ready, BIOS attempted to boot an operating system from a
diskette. If the drive was not ready or there was no system area on diskette, BIOS
tried to boot an operating system from hard disk C:.
At present, BIOS allows booting operating systems not only from diskettes or hard
disks, but also from CD-ROMs, DVDs and other devices. If there are several hard
disks installed in your computer labeled as C:, D:, E:, and F:, you can adjust the
boot sequence so that an operating system is booted from, for example, disk E:. In
this case, you have to set the boot sequence to look like E:, CD-ROM:, A:, C:, D:.
This does not mean that booting is done from the first disk in this list; it only means that the
first attempt to boot an operating system is to boot it from this disk. There may be no
operating system on disk E:, or it can be inactive. In this case, BIOS queries the next drive in
the list. Errors can happen during the booting, see A.2.5 «Hard disk initialization errors».

The BIOS numbers disks according to the order in which they are connected to IDE
controllers (primary master, primary slave, secondary master, secondary slave);
next go the SCSI hard disks.
This order is broken if you change the boot sequence in BIOS setup. If, for
example, you specify that booting has to be done from hard disk E:, numbering
32
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starts with the hard disk that would be the third in usual circumstances (it is usually
the secondary master).
After you have installed the hard disk in your computer and have configured it in
BIOS, one can say that the PC (or the motherboard) «knows» about its existence
and its main parameters. However, it is still not enough for an operating system to
work with the hard disk.
A.2.4

AwardBIOS
Below, we provide an example of configuring hard disks in AwardBIOS.
The Main AwardBIOS menu, which is responsible for configuring hard disks on
motherboards for Celeron, Pentium II, III, IV and AMD Athlon, Duron and Sempron
processors usually looks like this:
AwardBIOS Setup Utility
Main

Advanced

Power

Boot

Exit

System Time
System Date

[16:16:35]
[01/10/2001]

Item Specific Help:

Legacy Diskette A
Legacy Diskette B
Floppy 3 Mode Support

[1.44M, 3.5in]
[None]
[Disabled]

<Enter> to go to submenu.

Primary Master

[Auto]

Primary Slave

[Auto]

Secondary Master

[Auto]

Secondary Slave

[Auto]

Language

[English]

Supervisor Password

[Disabled]

User Password

[Disabled]

Halt On

[All but Disk/Keyboard]

Installed Memory

[Disabled]

F1 Help ↓
Select Item -/+
Change Values
F5 Setup Defaults
Esc Exit ←→ Select Menu Enter Select Sub-Menu F10 Save and Exit

Place the marker on the Primary Master line and press the Enter key to get to the
screen that looks like this:
AwardBIOS Setup Utility
Main
Primary Master [Auto]
Type

[Auto]

Item Specific Help:
<Enter> to select the type
of the IDE drive.
[User Type HDD] allows
you to set each entry on
your own.
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Warning: Ultra DMA Mode
3/4/5 can be enabled only
when BIOS detects
Shielded 80-pin cable.

F1 Help ↓
Select Item -/+
Change Values
F5 Setup Defaults
Esc Exit ←→ Select Menu Enter Select Sub-Menu F10 Save and Exit

Place the marker on the value of the Type parameter ([Auto] in this case) and press
the Enter key to open the list of possible values of this parameter; for example:
None
Auto
User Type HDD
CD-ROM
LS-120
ZIP-100
MO
Other ATAPI Device

Use the Up and Down keys to select the User Type HDD value and press the Enter
key to get to the following screen:
AwardBIOS Setup Utility
Main
Primary Master [User Type HDD]

Item Specific Help:

Type
Translation Mode

[User Type HDD]
[LBA]

<Enter> to select the type
of the IDE drive.

Cylinders
Head
Sector
CHS Capacity

[………0]
[……0]
[…0]
0MB

[User Type HDD] allows
you to set each entry on
your own.

Maximum LBA Capacity

0MB

Multi Sector Transfer
SMART Monitoring
PIO Mode

[Maximum]
[Disabled]
[4]

Warning: Ultra DMA Mode
3/4/5 can be enabled only
when BIOS detects
Shielded 80-pin cable.

Ultra DMA Mode

[5]

F1 Help ↓
Select Item -/+
Change Values
F5 Setup Defaults
Esc Exit ←→ Select Menu Enter Select Sub-Menu F10 Save and Exit

Enter the values of Translation Mode, Cylinders, Head and Sector parameters (you
can find them on the case of the hard disk) to finish the initial configuring of the
hard disk with BIOS.
34
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Translation Mode parameter can have the following values:
LBA
Large
Normal
Match Partition Table
Manual

New versions of AwardBIOS menu have the Boot item. The screen of the Boot
menu, which is responsible for adjusting the boot sequence, looks like this:
AwardBIOS Setup Utility
Main

Advanced

Power

Boot

Exit

1. ATAPI CD-ROM
2. Removable Device

[None]
[Legacy Floppy]

Boot Sequence:

3. IDE Hard Drive
4. Other Boot Drive

[IBM-DTLA-307020]
[Disabled]

Plug & Play O/S
Boot Virus Detection

[No]
[Enabled]

<Enter> to select the device To select the boot sequence, use up or down Arrow.

Quick Power On Self Test
Boot up Floppy Seek
Full Screen Logo

[Enabled]
[Enabled]
[Enabled]

Press <+> to move the
Device up the list, or
<-> to move it down
the list

F1 Help ↓
Select Item -/+
Change Values
F5 Setup Defaults
Esc Exit ←→ Select Menu Enter Select Sub-Menu F10 Save and Exit

Place the marker on the field to the right of the 3. IDE Hard Drive item and press the
Enter key to open the list of all hard disks connected to your computer and detected
by BIOS, together with the Disabled line; for example:
Disabled
Quantum FireBALL_1700A
IBM DTLA-307020
Quantum FireBALL_1700A

This device sequence in the upper left corner of the screen means that when
looking for a boot disk, the BIOS will first query the CD-ROM (1. ATAPI CD-ROM),
but there is no CD-ROM in the current configuration. Next it queries the floppy disk
drive (2. Removable Device). Only if none of these disks contains an operating
system, does BIOS query the hard disk (3. IDE Hard Drive) that has been selected
from the list.
Select an item of the list with the Up or Down keys and move the device up the list
or down it with help of + or - keys. This will change the boot sequence. For
example, you can select the boot sequence as the one shown below:
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AwardBIOS Setup Utility
Main

Advanced

Power

Boot

Exit

1. Removable Device
2. ATAPI CD-ROM

[Legacy Floppy]
[None]

Boot Sequence:

3. IDE Hard Drive
4. Other Boot Drive

[IBM-DTLA-307020]
[Disabled]

Plug & Play O/S
Boot Virus Detection

[No]
[Enabled]

<Enter> to select the device To select the boot sequence, use up or down Arrow.

Quick Power On Self Test
Boot up Floppy Seek
Full Screen Logo

[Enabled]
[Enabled]
[Enabled]

Press <+> to move the
Device up the list, or
<-> to move it down
the list

F1 Help ↓
Select Item -/+
Change Values
F5 Setup Defaults
Esc Exit ←→ Select Menu Enter Select Sub-Menu F10 Save and Exit

After setting the specified parameters, use the Left or Right keys to select the
Exit menu item. Reply positively to the prompt on saving the specified
parameters.
For AwardBIOS for motherboards for Pentium, Pentium Pro processors (i.e the ones
older than those described above) and AMD-K5/K6, the standard CMOS setup
screen looks like this:
ROM PCI/ISA BIOS (2A69JA2A)
STANDARD CMOS SETUP
AWARD SOFTWARE, INC.
Date (mm:dd:yy)
Time (hh:mm:ss)

: Fri,
: 11:

HARD DISKS
Primary Master
Primary Slave
Secondary Master
Secondary Slave

:
:
:
:
:

May
33:

15
53

1998

TYPE SIZE CYLS HEAD PRECOMP LANDZ SECTOR MODE
Auto
0
0
0
0
0
0
Auto
Auto
0
0
0
0
0
0
Auto
None
0
0
0
0
0
0
0
None
0
0
0
0
0
0
0

Drive A : 1.44 M
Drive B : None
Video : EGA/VG

Base Memory:
Extended Memory:
Other Memory:

0K
0K
512K

Total Memory:

512K

Halt On: All Errors
ESC : Quit

↓→←:

Select Item

F1 : Help

(Shift) F2

Change Color

PU/PD/+/- : Modify

The Type parameter can have Auto, Not Installed or User Defined values. In the
latter case, you have to specify the values of other parameters manually (except
MODE) according to the information on the case of the hard disk.
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The purpose of the MODE and LANDZ parameters is described in the note above. The
PRECOMP parameter is the so-called precompensation parameter and is important only for
the older hard disks (MFM and RLL). IDE disks ignore this parameter.

In earlier BIOS versions, the boot sequence was set in the BIOS FEATURES setup
section in the Boot Sequence line where you could select the most typical boot
sequences, for example C:; A:;CD-ROM: or CD-ROM:; C:; A:, and other.
A.2.5

Hard disk initialization errors
Devices are usually initialized successfully, but sometimes errors can happen. Typical
errors related to hard disks are reported by the following messages:
PRESS A KEY TO REBOOT
This error message is not directly related to errors during hard disk initialization.
However, it appears, for example, when the boot program finds no operating
system on the hard disk, or when the primary partition of the hard disk is not set as
active.
DISK BOOT FAILURE,
INSERT SYSTEM DISK AND
PRESS ENTER
This message appears when the boot program finds no available boot device, be
that a floppy or a hard disk, or a CD-ROM.
C: DRIVE ERROR
C: DRIVE FAILURE
ERROR ENCOUNTERED
INITIALIZATION HARD DRIVE
This message appears when it is impossible to access the C: disk. If the disk is
known to be functional, the reason for this error message is probably incorrect
settings/connections of:
• hard disk parameters in BIOS setup
• jumpers on the controller (master/slave)
• interface cables
It is also possible that the device is out of order, or the hard disk is not formatted.
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Appendix B. Partitions and file systems
B.1

Hard disk partitions
The mechanism that allows you to install several operating systems on a single PC
or to carve up a single physical disk drive into multiple “logical” disk drives is called
partitioning.
Partitioning is performed by special applications. In MS-DOS and Windows, these
are FDISK and Disk Administrator.
Acronis offers a special application suite that will handle disk administration tasks. This
product is Acronis Disk Director Suite. It includes disk partitioning, multibooting, partition
recovery and other disk management applications.

Partitioning programs perform the following:
• create a primary partition
• create an extended partition that can be split into several logical disks
• set an active partition (applied to a single primary partition only)
Information about partitions on a hard disk is stored in a special disk area – in the 1st sector
of cylinder 0, header 0, which is called the partition table. This sector is called the master boot
record, or MBR.
A physical hard disk might contain up to 4 partitions. This limit is forced by the partition table
that is suitable for 4 strings only. However, this does not mean you can have only 4 operating
systems on your PC! Actually, existing applications called disk managers support far more
operating systems on disks. For example, Acronis OS Selector enables you to install up to 100
operating systems!

B.2

File systems
An operating system gives the user the ability to work with data by supporting some
type of file system on a partition.
All file systems are made of structures that are necessary to store and manage
data. These structures are usually composed of operating system boot sectors,
folders and files. File systems perform the following basic functions:
• track occupied and free disk space (and bad sectors, if any)
• support folders and file names
• track physical location of files on disks
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Different operating systems use different file systems. Some operating systems are
able to work with only one file system while others can use several of them. Here
are some of the most widely used file systems .
B.2.1

FAT16
The FAT16 file system is widely used by DOS (DR-DOS, MS-DOS, PC-DOS, PTS-DOS
and other), Windows 95 and higher operating systems and is supported by most
other systems.
Main features of FAT16 are the file allocation table (FAT) and clusters. FAT is the
core of the file system. To increase data safety, it is possible to have several copies
of the FAT (there are usually two of them) on a single disk. A cluster is a minimum
data storage unit in FAT16 file system. One cluster contains a fixed number of
sectors. FAT stores information about what clusters are free, what clusters are bad,
and also defines in which clusters files are stored.
The FAT16 file system has a 2GB limit that permits a maximum 65,507 clusters that
are 32Kb in size. (Windows NT/2000/XP support partitions up to 4GB with up to
64Kb clusters). Usually the smallest cluster size is used to make the total cluster
amount within the 65,507 range. The larger a partition is, the larger its clusters are.
Usually the larger the cluster size, the more disk space is wasted. A single byte of data could
use up one cluster, whether the cluster size is 32Kb or 64Kb.

Like many other file systems, the FAT16 file system has a root folder. Unlike others,
however, its root folder is stored in a special place and is limited in size (standard
formatting produces a 512-item root folder).
Initially, FAT16 had limitations on file names. They could only be eight characters
long, plus a dot, plus three characters of name extension. However, long-name
support in Windows 95 and Windows NT bypasses this limitation. The OS/2
operating system also supports long names, but does so in a different way.
B.2.2

FAT32
The FAT32 file system was introduced in Windows 95 OSR2. It is also supported by
Windows 2000 and higher. FAT32 is an evolved version of FAT16. Its main
differences from FAT16 are 28-bit cluster numbers and a more flexible root, whose
size is unlimited. The reasons FAT32 appeared are the support of large hard disks
(over 8GB in capacity) and the impossibility to implement any more complex file
system into MS-DOS, which is still the base for Windows 98/Me.
The maximum FAT32 disk size is 2 terabytes (1 terabyte, or TB, is equal to 1024
gigabytes, or GB).

B.2.3

NTFS
NTFS is the main file system for Windows NT/2000/XP/2003/Vista. Its structure is
closed, so no other operating system is fully supported. The main structure of NTFS
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is the MFT (master file table). NTFS stores a copy of the critical part of the MFT to
reduce the possibility of data damage and loss. All other NTFS data structures are
special files. NTFS stands for NT File System.
Like FAT, NTFS uses clusters to store files, but cluster size does not depend on
partition size. NTFS is a 64-bit file system. It uses unicode to store file names. It is
also a journaling (failure-protected) file system, and supports compression and
encryption.
Files in folders are indexed to speed up file search.
B.2.4

Linux Ext2
Ext2 is one of the main file systems for the Linux operating system. Ext2 is a 32-bit
system. Its maximum size is 16TB. The main data structure that describes a file is
an i–node. A place to store the table of all i-nodes has to be allocated in advance
(during formatting).

B.2.5

Linux Ext3
Ext3 is a journaling file system used by the Linux operating system. It is forwardand backward-compatible with Linux Ext2. It has multiple journaling modes and
broad cross-platform compatibility in both 32- and 64-bit architectures.

B.2.6

Linux ReiserFS
ReiserFS was officially introduced to Linux in 2001. ReiserFS overcomes many Ext2
disadvantages. It is a 64-bit journaling file system that dynamically allocates space
for data substructures.
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